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Copyright 

 

Copyright 
 
©2002 Premier Assistive Technology, Inc..  All Rights Reserved.  This documentation and the accompanying 
software are copyrighted materials.  Making unauthorized copies of this material is prohibited by law.  No part 
of the software or documentation may be reproduced, transmitted, transcribed, stored in a retrieval system or 
translated into any human or computer language without prior written permission of Premier Assistive 
Technology, Inc.  Premier Assistive Technology, Inc. asserts its "Moral Right" to be identified as the author of 
this work, in all jurisdictions which recognize the "Moral Right." 

 

Notice 
 

UNLESS OTHERWISE PROVIDED BY WRITTEN AGREEMENT WITH PREMIER ASSISTIVE 
TECHNOLOGY, INC.,  THIS PUBLICATION, AND THE SOFTWARE SOLD WITH THIS PUBLICATION 
ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND EITHER EXPRESSED OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT 
THIS PARTICULAR PURPOSE.  THE ENTIRE RISK ARISING OUT OF THE USE OR PERFORMANCE 
OF THIS PUBLICATION AND SOFTWARE REMAINS WITH YOU, THE USER.  IN NO EVENT SHALL 
PREMIER ASSISTIVE TECHNOLOGY, INC., OR ANY OF ITS SUPPLIERS, BE LIABLE FOR ANY 
LOST PROFITS, LOST SAVINGS, DIRECT, INCIDENTAL OR INDIRECT DAMAGES OR OTHER 
ECONOMIC OR CONSEQUENTIAL DAMAGES, EVEN IF PREMIER ASSISTIVE TECHNOLOGY, INC., 
OR ITS SUPPLIERS, HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  PREMIER 
ASSISTIVE TECHNOLOGY, INC. RESERVES THE RIGHT TO MODIFY THIS DOCUMENT AT ANY 
TIME WITHOUT OBLIGATION TO NOTIFY ANYONE.  IN NO EVENT SHALL PREMIER ASSISTIVE 
TECHNOLOGY, INC. OR ITS SUPPLIERS’ LIABILITY UNDER THIS AGREEMENT EXCEED THE 
SUM OF ANY AMOUNTS PAID HEREUNDER BY THE CUSTOMER TO PREMIER ASSISTIVE 
TECHNOLOGY, INC. OR THE SUPPLIER. 

 
 
Trademarks 
 

These other marks include, but are not necessarily limited to: WINDOWS, WINDOWS 95, WINDOWS 98, 
WINDOWS NT, and WINDOWS 2000, Windows Me, Window XP, which are registered Trademarks of 
Microsoft Corporation.  Natural Voices is a registered trademark of AT&T. 

 
You shall not use any of the Trademarks, or Service marks of Premier Assistive Technology, Inc., or Microsoft 
Corporation, or any other entity, without the express written permission of such Trademark or Service mark 
owner. 
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Deletion or Modification 

 
If any portion of this manual, including but not limited to the "Notice" section above, is held 
to be unenforceable, that portion shall be deleted, and the remaining language shall be given 
its broadest legal effect. 

 
 
Premier Assistive Technology, Inc. 
1309 N. Williams St 
Joliet, IL 60435 
Phone: 815-927-7390 Fax: 815-722-8802 
E-mail: info@readingmadeeasy.com  
Web: www. readingmadeeasy.com 
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Text-To-Audio Quick Start Guide 

Text-To-Audio Introduction 
 

Text-to-Audio is very straightforward and easy to use.  The following notes comprise a “Quick Start” set of 
guidelines that will get the user up and running quickly. There are only 5 major steps from selecting input 
text to the creation of the audio files: 
 

1. Adding a File (This simply involves selecting an input file to be converted to audio) 
2. Setting the Output Path (For the resulting audio file) 
3. Selecting a Voice for the Audio 
4. Selecting an Audio File Type 
5. Creating the actual Audio File 

 
Of course, once you’ve created an audio file, the user is free to play the file at his/her 
convenience using any “media player” software on a PC, or other hardware such as CD or MP3 
players.  It is literally that simple.   
 
With the help of this Quick Start guide, you’ll be a Text-to-Audio expert in no time !!! 
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Starting Text-To-Audio 
 

Select the Start menu  and then select PROGRAMS .  This will give the 
user a list of all the programs on his/her computer.  Once this list is opened, find the Premier AT  
program group.  In this group, you will see several items listed.  Select the item labeled Text-to-
Audio. 
 
There are two ways to start the Text-to-Audio feature.  By either selecting it with the mouse or 
by highlighting it and pressing the enter key. 
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Adding a file 
 

The first step to using Text-To-Audio is to add a file.  Select the ADD icon  or select the 
Add menu option located in the File menu.  This will open up the add file dialog box. 

 
 
Browse the computer and find the desired files you would like to convert into audio.  Text-To-
Audio can be used to open Microsoft Word, HTML, Standard Text and Rich Text Format style 
documents.  
 
Once a file has been added to Text-to-Audio, the file will appear as a page in a notebook. 

 
 

File Name

On this screen you will see several types of information regarding the document with varying 
output types.  In the above example, the output file name and path are listed.  This tells the 
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user the exact location of the file along with the resulting output.  To change the output 
location see “Setting the output path”.  The original document name and path are displayed in 
the box named “File Name”.  Below the file name is a box labeled “Voice”.  This box 
displays the name of the voice used to create the audio file.  The file size displays the number 
of characters in the document.  As a rule of thumb, 1000 characters equals a minute of audio.  
In this example, the file will create 13 minutes of audio.  It’s recommended audio files be 
kept to an hour or less.  Each 1000 characters will produce a 500K file as a result, and a 10 
minute audio file will require approximately 5 MB of storage using the standard WAVE 
audio format. 
 

 
 

Setting The Output Path 
 

Once you have added a file, the output path can now be set.  The output path is used to tell the 
Text-to-Audio option the best location to place the audio file after it has been created.  The 
output path for each file can be changed or set as a default.  This allows every subsequent file to 
be placed in that same location.  Note: To change the output path the user must have added at 
least one document. 

 

From the settings menu select CHANGE OUTPUT PATH.    This will 
open the “Select Path” dialog box. 
 

 
 

The user can then select the drive and the directory he/she wants the resulting audio file to be 
placed in.  On the bottom of the screen, you will see a check box labeled “Set as Default 
Path”.  Leaving this box checked, will result  in all created files to be placed in the selected 
folder.  This will remain as the default the next time Text-to-Audio is started. 
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Changing the Voice 
 

To select a reading voice, click on the VOICES icon  or press the F12 key.  This will 
open the select “Voice Options” dialog box and display the current voice. 

 

 
 
 

Select a voice from the list and then move the slider left or right to change the speaking rate 
and the pitch.  Then click on the RESET button to reset the defaults.  To save the desired 
voice, simply select the OK button.  This will enable the default setting for any file added 
from this point. 

 

Selecting an output type 
 

Text-to-Audio can create nine different styles of audio files.  The most common type of 
audio is MP3 and Standard Wave, with MP3 being the default.  Which file format do I need?  
Selecting a file format is very simple.  Standard Wave, DSP or GSM are recommended when 
making an audio CD.  DSP and GSM are a type of Wave file, and due to compression more 
audio can be placed in these smaller files.  Not surprisingly, MP3 is a format most commonly 
used with an MP3 Player.    

 

Creating the audio file 
 

You are now ready to create your first audio file.  You’ve selected a file, selected a location, 
and the type of desired file.  Now you are ready to start the conversion process.  To begin, 

simply click the START icon  or press CTRL+P.   Once the process has started, you 
can stop it at any time by selecting the STOP icon (Note: same as START icon, but with a 
red light). 
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Stop Icon

Processing

 
 

While the file is processing, a progress bar in the lower right hand corner of the screen will 
appear.  This moving progress bar is not a “percentage of completion”, but rather it shows the 
user Text-to-Audio is still in operation.  When a document is completed, Text-To-Audio will 
automatically flip pages and proceed to the next document.  When the entire book has been 
created, Text-To-Audio will notify the user with “done” appearing in the lower left hand 
corner.  The progress bar in the lower right hand corner will also stop moving. 

 
 

Playing the Audio file 
 

When Text-to-Audio is complete, you can now play your audio files.  This can be done by 
going to the location where the files in the output path have been directed.  Simply double 
click the file and the default media player will automatically play them.  These audio files 
can be played on both Microsoft Windows and Macintosh computers. 

 
In Summary 
 

Congratulations !  By now, you should have successfully created your first audio file from 
text.  With just a little more practice, you will be able to tackle more complex Text-To-Audio 
conversion tasks.   If you have any further questions about Text-to-Audio, please checkout 
our website at www.readingmadeeasy.com. 
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Text-To-Audio 

Text-To-Audio Quick Reference 
 

 
Add a File      CTRL + F 
New     CTRL + N 
Remove a File    CTRL + R 
Exit     Alt + F4 
View Document   F6 
Create an Audio File   CTRL + C 
Process All    CTRL + P 
MP3 Player    CTRL + M 
Hear the Current Voice  F11 
Voices     F12 
Help Topics    F1 
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Main Screen 
 
The main screen consists of three parts.  Part 1 is the notebook.  As files are added for conversion to 
the audio files, pages are added to the notebook.  The name of the output file is listed on both the tab, 
and in the status bar in the lower left hand corner. 
 

 
 
The left side of the notebook contains all the settings for the converted file, with the right side 
displaying the document.  Each file can have its own settings. The settings are as follows: 
 

Output File Name:  This field contains the pathname and the output file name.  When the 
process is complete, this is the location of the finished audio file.  A default output directory 
can be set, and the user can also change this value by double clicking the field or by selecting 
CHANGE OUTPUT FILE from the settings menu. 

 
File Name:  This is the name of the original file name.  This process will not alter the 
original document. 

 
Voice:  The voice field displays the names of the voice which will be used during the audio 
file create process.  The user has the option of changing the voice by simply double clicking 
the voice listing in the menu, or going to settings menu and selecting VOICES. 

 
File Size:  The file size is the number of characters in the document. 

 
Voice Rate:  The voice rate is the speed at which Text-To-Audio speaks.  This rate cannot be 
adjusted once the file has been created.  The Range for the speed is from a (–) 10 to (+) 10, 
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with 0 being the default speed.  To change this value, double click this field or go to the 
settings menu and select VOICES. 

 
Voice Pitch:  The voice pitch is the numeric value of the pitch used during the creation of the 
audio file.  The pitch of the reading voice can also be adjusted by double clicking the voice 
pitch, or going to the settings menu and selecting VOICES. 

 
File Output Type:  Text-To-Audio can generate two different file types with the default file 
type being MP3.  The user can select the output type from this list, or go to the settings menu 
and select output type.  Text-To-Audio can create the following file types: 
 

MP3:  The MP3 files provide a good compression ratio, and also support variable 
speeds.  The compression ratio is directly related to the bit rate settings.  Text-To- 
Audio supports sampling rates from 16 to 256 Bits. 
 
Standard Wave:  Standard Wave file is an uncompressed wave and creates the 
largest of all the file types.  Use this file format if a Natural Wave file is needed. 
 

 
Segment The Audio:  When this section is checked, the audio file will be broken up into 
defined segments.  See Audio Segmenting section later in this manual. 
 
Define Segment:  When the user selects the DEFINE SEGMENT button, he/she can now 
segment the file.  See Audio segmenting section later in this manual. 
 
Part 2 of the screen is the status bar.  The status bar lists the selected file.  The status bar will 
also let the user know what the progression is of the conversion process and reading of the 
document. 

 
Part 3 is the tool bar with large icons.  The tool bar gives the user quick access to all of the 
major functions of Text-To-Audio.  Each tool bar item has a “hot key” equivalent.  For more 
information about the “hot keys” see the Quick Reference Section at the front of this manual. 
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Adding a Document 
 
 

Adding a document:  To add a document, press CTRL+ F or click on the ADD icon .  
The Open Dialog Box will then appear. 

 

  
 
The dialog box functions the same as any Microsoft Windows Dialog Box.  The user can 
select the location, select the file type, or select a file name.  Scan & Read can save in the 
following formats:  Microsoft Word 97, Standard Text Files, HTML Documents, and Rich 
Text Format. 
 
Press the Enter key once the desired file has been located.  The document will then open and 
displayed on the tab.  A new tab is created for each file added, and the name on the tab is the 
file name. 

New  
 

With Text-To-Audio, it is not necessary for the file to be presently located on your computer.  
For example: While surfing the Internet, a user comes across an article he/she wants to 
convert to audio.  The user only needs to open Text-To-Audio and then select NEW from the 
file menu. The user can also press CTRL+N, paste the article into the blank page, and give 
the file a name. 

Removing a Document 
  

To remove a document, press CTRL + R or click the REMOVE icon.  This will 
remove the current document displayed on screen.  When the user removes a file, the system 
will automatically delete the tab which the file is located. 
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Leaving Text-To-Audio 
 

To quit Text-To-Audio, select Exit from the file menu or press ALT + F4. 
 

Importing a PDF File 
 

Text-To-Audio can take an existing PDF file and import it.  The import feature lets the user select the entire 
book or a range of pages.  The import feature does more than simply grab the text from the PDF file.  The 
wizard will identify the different page layouts and arrange them automatically into continuous reading format.  
When the user looks at a page, his/her eyes can separate the columns and follow the flow of text.  However, 
when listening to the text, the user doesn’t see the columns.  Problems with sound and tone can arise if the 
computer actually reads across the page.   To compensate for this, the Auto Arrange feature identifies each page 
to determine the specific order to read it in.  Auto Arranged then arranges the text in the specific order, enabling 
the user to make perfect sense of the document. 

 

To import a PDF file select the Import PDF WIZARD icon  from the toolbar.  This will open the 
Wizard window. 

 
 

Once the window has opened, select the SELECT PDF button. This will open a standard windows dialog 
window, which allows the user to navigate to desired location of the PDF file.   
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Once the user finds the desired file for importing, simply double click the file, or select it from the main menu 
screen, and select the OPEN button.  The PDF Import Wizard is able to open and utilize virtually any PDF file. 
For this option to be successful, the file should not be password protected.  Wizard offers the user a smooth and 
easy option when downloading books from Google Books. 

 

 
 

When the user converts a PDF Book to audio, he/she may not need to convert each and every page.  At times 
there are copyright pages and preface pages are not needed for conversion.  A downloaded book from Google 
Books has an initial page which the user has no need to listen to or convert.  The Wizard allows the user select a 
range of pages to convert.   Thus, it’s not necessary to start conversion with the first page. 
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The navigation buttons are below the Preview window  .  These buttons 
allow the user navigate page by page, or quickly navigate to the first or last page.  This gives the user the option 
of seeing the exact starting pages.  The default mode is Convert All Pages. 

 

 
 

Select SPECIFY PAGES TO CONVERT if you do not wish to convert the entire book.  When the user selects 
this option, he/she can then enter in the specific range of pages to be converted. 

 

 
 

Text-To-Audio converts documents into audio formats.  The output is an audio only process, and all images will 
be removed.  Only the text will be saved, and any pictures will be ignored.  Once the user has made the page 
conversion selection, simply select the PROCESS button.  The Wizard will start to process, and the pages are 
added one page to another, into a single text file. 

 
 

Once all the pages have been processed, select the CLOSE button to close the window. The user will then be 
returned to the main screen again, and the document created will be automatically added. 
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The file has now been converted to audio. 

 
 

 

Read Menu 
 

The user can hear the actual sound of the document in the same way he/she can view the 
document, with all the desired settings made to the file.  To view and read the document, 
select the VIEW DOCUMENT option from the Read Menu.  For more information about the 
Read window see the “Reading a Document Section”. 

 

Viewing A Document 
 

The user can preview a document, hearing exactly how it will sound.  The user must have the 
document previously loaded into Text-To-Audio.  After the document has been loaded, the 

user only needs to click on the PREVIEW Icon  or select PREVIEW from this 
menu. For more information on the Preview window see Viewing A Document later in this 
doucment 
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Hear Voice 
 

By selecting the HEAR VOICE option, the user can hear the current voice settings without 
having to change them.  To test the voices, select the F11 key from the Read menu. 
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Convert Files 
 

The CONVERT FILE menu gives the user various options for file conversion.  The user can 
use Text-To-Audio to convert specific documents to standard wave files.  The user can 
further take those wave files and convert them to one of eight other file formats. 

 

Create Audio File 
 

The CREATE AUDIO FILE option can be used to create one file.  When this option is 
selected, it will convert the current document to an audio file.  This process only creates the 
active document to the specified file type. 

 

Process All 
 

The PROCESS ALL option creates audio files from the very first item in the list to the very 
last.  PROCESS ALL then automatically flips the pages in the notebook, reflecting which 
document is currently being processed.  The creation process is a two fold process.  First, the 
document is read into an audio file, and then compressed into the selected audio file type.  If 
only a wave file is desired for encoding, the process is omitted. 
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Audio file Segmenting 

 
Text-To-Audio supports two types of audio file segmenting.  Segmenting is supported by (1) Length 
of time and (2) Discrete bookmarks. When the user adds a file into Text-To-Audio, audio 
segmenting is done by default.  The user can turn off Audio File Segmenting simply by removing the 
check from the “Segment the audio” check box. 
 

 

Remove this 
checkmark to 
stop file 
segmenting 

 
 
“Timed Segments” are used to breakup an audio file into equally timed chunks based on duration.  
The specific duration of time for these segments can be specified by the user.  Each audio file will be 
approximately the same size with the exception of the last file.  That file may be smaller than the 
specified time length depending on how much time remains in the document after the last “equally 
timed” segment.  If the total file size is smaller than the specified time (e.g. 60 minutes), the entire 
segment it will be placed into a single audio file. 
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“Bookmark Segments” are the manual process of breaking up a document into specific chunks 
which may be variable in size.  This is based purely on the user’s insertion of bookmarks into a 
document.  For example: If the user wants to turn each chapter of a book into its own audio for 
easier navigation through a book, he/she will need to first select “bookmark” as the segment type 
(“See Setting Bookmarks” later in this section).  Text-To-Audio will then create a separate audio file 
whenever it finds a bookmark.  Each segment will be automatically named in sequential order so 
they are easy to identify. 
 
To segment a file, the user must first add the file to Text-To-Audio. (See “Adding a File” earlier in 
this manual). Select the  DEFINE SEGMENT button. This will open up the file segment 
window. 
 
 

 
 

At the top, the user will see the file name (of the input file) and the audio output file type. Located 
below the file name is the segment type.  The user can select either “BOOKMARK” or “TIMED”. 
 

 
 
If the user has selected BOOKMARK, he/she will need to manually insert the bookmarks into the 
text.  Without bookmarks, the document will simply be turned into one large audio file.  If the user 
selects TIMED, he/she must specify a time interval.  The default is 10 minutes, with a maximum of 
60 minutes. Note: A maximum of only 60 minutes of audio is allowed, due to the audio capacity of 
the CD.  If a larger audio file larger than one hour is desired, the user must use the bookmarks 
option, and manually insert the breaks. 
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Using Time Segments 
 

Timed Segments:  For timed segments, the user must make sure the TIMED radio button is 
selected, along with the desired audio length from the dropdown list. Once the user has done 
this, he/she only needs to click on the RETURN button.     This takes the user back 
to the Text-To-Audio main screen.  The user can then review the segments before closing 
this window, by simply clicking the CREATE SEGMENT button . This will 
display all the segments in the segment list box on the left hand side of the screen. 

 

 

Individual Audio 
segments 

 
 

Viewing A Segment 
 

The user can view any of these segments by simply double clicking the specific segment or 
by selecting it from the VIEW SEGMENT button.  The user can have as many as 999 
segments per document.  Each segment contains the file name followed by the segment 
number.  This naming process is used to allow the user the option of sorting the segments in 
a folder. The segments will automatically be placed in the proper alphabetic / numeric 
sequence. 

 
 

When the user selects the VIEW SEGMENT button, the selected segment will open in the 
Preview Window.  The user can then use the Preview Window and have the segment read 
aloud.  It should be noted, any editorial changes made in the Preview Window will not be 
saved.  This is the only occasion the changes are not saved in the Preview Window. 
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For more information on using the Preview Window, see Using the Preview Window later in 
this document.  Once the user has finished previewing the segment, select RETURN. This 
will return the user back to the segment window. 
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Using Bookmark To Segment A Document 
 

Bookmarks can be used to manually segment a file.  When the BOOKMARK RADIO button 
is selected, Text-To-Audio will search through a file, find the desired bookmark, and create 
an audio file for that section.  To insert bookmarks into a file, select the INSERT 
BOOKMARKS button .  This will open the Preview 
Window. 

 

 

Insert Bookmark 
Button 

 
 
 

Once the Preview Window is opened, the user needs to find the exact location on the 
document where the break is to be placed.  Simply place the cursor at the desired point and 

click on the MARK button  or press the F9 key.  The mark will be inserted at the desired 

spot.  The mark is a Greek beta symbol.   The symbol is made in large print and bold 
so the user can visually see it.  To remove the bookmarks, simply delete it as you would any 
other character in the text.   There are no hidden characters.  If bookmarks are present in the 
original document, the bookmarks will not interfere with that document.  Note: These 
documents are created by a word processing application (e.g. MS WORD). 

 
A Find option has been added to the Preview Window.  To find all the chapters of a book, 
simply search for the word “chapter” and place a bookmark whenever the desired word is 
found.  To activate the Find option, click on the FIND button  or select FIND from the 
Edit menu.   This will open the Find dialog box. 
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In the Find What edit box, simply type the specific word or text, and click the FIND NEXT 
button.  Continue pressing the FIND NEXT button until the desired text or word is found, or 
the entire document has been searched.  This is a very helpful tool for finding all your 
bookmarks, as the Beta symbol is seldom used. 

When inserting your bookmarks is complet, click the RETURN icon  or press Alt+F4 to 
close this window.  The Bookmark Window will prompt the user, asking if all changes are to 
be saved.  If yes, these bookmarks will be saved.  If no, all the bookmarks will be lost. 
 
The user is then returned to the Segment Window, for review all the segments he/she has 
created.  Select the RETURN button when finished, to go back to the main Text-To-Audio 
window. 
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Settings Menu 
The Settings Menu has 5 options.  The user can change the voices, output path, output file 
name, output file type, and open the built in MP3 Player. 

 

Voice 
 

The system comes with 5 standard voices.  The user can change the voices at any time by 
simply pressing the F12 key, or by pressing ALT+T.  This will bring up the Settings menu.  
The user can then select VOICES from the menu (see below). 
 

 
 
The user can also scroll through the list of voices until the desired voice is found.  As a voice 
is selected, the voice will be read aloud, giving the user a sample of the actual voice.. 
 
Once the desired voice has been selected, the user can adjust the rate by moving the first slide 
bar to the right for faster, and left for slower.  Select the RESET to set everything back to the 
default settings.  Both the Rate and Pitch can be adjusted from a (–) 10 to (+) 10, with 0 
being the default. 
 
Adjusting the Pitch is similar to changing the voice rate.  Moving the slider to the left will 
decrease the pitch, and sliding it to the right increases the pitch.  As both the Rate and Pitch 
are being adusted, the user will hear hear the actual sounds of the new settings. 
 
Select the OK button to close the window and save the changes.  The selected changes will 
be set to the current document and also saved as the default.  The next document added will 
have these voice settings.  If  a document is not opened, the voice setting will be set as the 
default, and will be applied to the next file added to Text-To-Audio. 
 
Selecting the CANCEL button will close the window without saving any of the changes. 
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Change Output Path 
 

To change the output path, select the desired file the output will be redirected to.  From the 
File menu, then select the Change Output Path option.  This will open the Selected Directory 
window. 

 

 
 
Navigate through the computer or network to find the desired directory and then select the 
OK button.  On the bottom of the screen is a box labeled SET.  This is the default output 
path.  By default this box is always checked, and when the OK button is selected, it will 
automatically save the path the user has selected.  This path will remain as the default path 
until it’s changed again.  Any new file added to Text-To-Audio will be set to this output path. 

 

Change File Name 
 

The user can change an output file name by selecting the Change Output File Name option 
from the Settings menu.  This will open the file name dialog box. 

 

 
 

The user can now change the file name.  File extensions are not necessary.  The correct 
extension will be added later, if an extension is not added at this time.  When finished, select 
the OK button and the new file name will be saved to the current output path.  Do not add or 
change the path in this window.  If the user desires a different path, select Change Output 
Path from the Settings Menu. 
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Audio File Settings 
 

Five of the output files have adjustable settings.  Changing these settings will set the 
default for that output type.  The user can adjust settings for MP3, VOX, OGG, GSM, 
and ADPCM file types. 

 

 
 

MP3:  The user can adjust the frequency, Channel, and MP3 sampling bit rate.  This 
sampling rate can be from 16K to 256K.  The higher the sampling bit rate the larger your 
audio file. 
 
The advanced MP3 setting will allow the user the option of changing the variable bit rate 
settings. 

 

 
 

VOX:  The user can adjust the frequency for the VOX.  The higher the frequency range 
the better the quality of the output. 
 
OGG:  For this style output, the user can adjust the frequency, the Kbits sampling rate 
and the channel type, either mono or stereo. 
 
GSM:  For the GSM File type the user can adjust conversion frequency from 8,000 KHz 
to 48,000 KHz. 

 
ADPCM:  For the ADPCM file format the user can adjust both the conversion frequency 
and the channel.  The channel can be either monotone or stereo. 
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Viewing A Document 

Viewing a Document Quick Reference 
   

Save     CTRL + S 
Print     CTRL + P 
Return    CTRL + R 
Cut     CTRL + X 
Copy     CTRL + C 
Paste     CTRL + P 
Select All    CTRL + A 
Read     F6 
Stop Reading   F7 
Insert A Bookmark  F9 
Read One line   Down Arrow 
Spell Word    Left or Right Arrow 
Help     F1 
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Viewing a Document 
 

The View Window is actually a talking word processor.  The user can add, proof, and 
even listen to a document.  As the document is being read, the word is highlighted, 
making it easy to follow along.  The user can also magnify the document up to 400%, 
making even the fine print easily readable.  The View Window gives the user a preview 
of exactly how the recorded document will sound.  Use the View Window to adjust the 
speed and pitch of the selected voice. 

 

 
 

 
To start listening to the document, simply click the START icon, and to stop, click on the 
STOP icon.  Hold down the CTRL key and press the right or left arrow to move to the next 
or prior word or to move word by word. 
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Saving A Document 
 

There are two ways to save a document: By either using the SAVE or SAVE AS features.  If 
an existing document has been opened, the user can use the SAVE feature.  The user 
however, will not be prompted for a file name.  If the document has not yet been given a 
name, and when the file is saved, a prompt  for a file name and type will be given to the user. 
 
To save an existing document, press CTRL+ S or from the File menu select SAVE from the 
list.  If the user wants to save the document as a different name or different file type, select 
the SAVE AS feature.  Once the SAVE AS dialog box opens, enter a new file name or select 
a different file type. 

 

Printing 
 

The printing feature only works with a word processor.  To print a document press CTRL+P.  
This will open the document in the word processor window and then print it. 
 
For mouse users: Select the File menu by clicking it with the left mouse button, and then 
select PRINT from the dropdown list. 

 

Returning 
 

To return to Text-To-Audio, select RETURN from the File menu or press CTRL + R.  This 
will close the reading screen and return to the Text-To-Audio main screen.  The user will be 
prompted to save the changes.  The reading screen is a full word processor, allowing the user 
to alter his/her documents.  All changes must be saved, otherwise when returning to the main 
screen, the changes will be lost. 

 

Edit 
 

The Edit menu only affects the word processor view.  The edit menu provides the user with 
common word processing tools.  It allows the user to cut, copy, or paste text within the word 
processing window. 
 
Cut:  To cut text from the word processor, select the desired text and then select CUT from 
the Edit menu.  Or the standard window command of CTRL+X can be used. 
 
Copy:  To copy text from the word processor, select the desired text and then select COPY 
from the Edit menu.  Or the standard windows command of CTRL+C can be used. 
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Paste:  To paste text into the word processor, place the cursor in the desired area, and select 
paste from the menu.  Or the standard windows command of CTRL+P can be used. 

 

Spell Check 
 

The spell-checker has an English dictionary with over 100,000 words.  To run spell-checker, 
make sure the document is displayed in the word processor window.  Start the spell checker 
by selecting it from the Edit menu.  Spell-Checker is started when it appears in the dialog 
window. 
 

 
 

The spell-check dialog has one edit box, two list boxes, and 11 buttons.  The spell-checker 
searches the document until it finds a word not in the dictionary.  When spell-checker finds a 
word, it will list all words which come close to matching the word, along with the highest 
probable replacement listed first. 
 
The Check-Spelling Dialog appears if a word requiring attention is detected.  The user can 
use the dialog box to specify whether the word should be ignored or replaced. 
 
Add button:  Causes the reported word to be added to the dictionary selected in the Add 
Words To list.  Use the ADD button if a correctly spelled word used often is reported as a 
misspelling (e.g., your family name).  If the word is not used frequently, instead select the 
IGNORE or IGNORE ALL buttons. 
 
Cancel button:  Stops the current spell-checking operation. 

 
Change button:  Changes all following occurrences of the reported word to be replaced.  If 
the problem word has been edited, the edited word is used as the replacement.  Otherwise, 
the selected suggestion is used as the replacement.  If the user wants only this occurrence of 
the word to be replaced, use the CHANGE button.  If the reported word is frequently 
misspelled, it’s suggested the user add the word to a user dictionary via the User Dictionaries 
Dialog Box.  The User Dictionaries dialog box can be displayed by selecting the 
DICTIONARIES button. 

 
Change All buttons:  Will change any following occurrences of the reported word to be 
replaced with the word in the Change To box.  If only this occurrence of the word is to be 
replaced, use the CHANGE button.  If the reported word is frequently misspelled, it’s 
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suggested adding the misspelling and the correction to a user dictionary via the User 
Dictionaries Dialog.  The user can display the User Dictionaries dialog by selecting the 
DICTIONARIES button. 

 
Suggestions:  Contains a word, which may be misspelled or otherwise incorrect, and is 
presented with a possible candidate replacement word.  The user can change the word by 
selecting the CHANGE button, or skip it by selecting the IGNORE button.  Note: The label 
of this box changes to "Not in dictionary" when a misspelled word is detected. 

 
Ignore button:  Causes this occurrence of a misspelled word to be skipped.  If the same 
misspelled word appears later, it will be reported. 

 
Ignore All buttons:  Causes this and all further occurrences of a misspelled word to be 
skipped.  The user should use this button if the word reported as a misspelling is actually 
spelled correctly.  If the word is frequently used, the user can ignore it permanently by 
selecting the ADD button. 

 
 

Reading a Document 
 

To read a document, press the F6 Key.  The reader starts where the current cursor is located.  
To make sure the cursor is at the beginning of the document, press CTRL+HOME, this 
places the cursor at the beginning of the document.  The system will continue until it reaches 
the end of the document.  To stop reading, press the F7 key.  Press the F6 Key to resume 
where you left off. 
 
To read one line at a time, use the Up or Down arrow.  The system will read the line the 
cursor has moved to. 
 
If you would like to spell out a word, use your Left and Right arrows.  The system will read 
the character that the cursor has moved over. 

 

Stop Reading 
 

To stop the system from reading press the F7 key.  To continue, press the F6 Key. 
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Settings 
 

The system will automatically save any changed settings.  The system will ‘start up’ the same 
way as it shuts down.  There are no configuration files to contend with. 
 

Voice 
 

The system comes with five standard voices.  The user can change the voices at any time by 
pressing the F12 key, or by using the ALT+T command to bring up the Settings menu.  You 
can then select VOICES from the menu (see below). 
 

 
 
As the user scrolls through the list of voices until he/she finds the desired voice, a sample of 
each voice is read aloud, giving the user an example of exactly how each sounds. 
 
Once the user has selected the desired voice, adjusments can be made to the rate by moving 
the first slide bar to the right for faster, and left for slower.  Select RESET to set all previous 
changes back to the defualt settings.  Both the Rate and Pitch can be adjusted from (-) 10 to 
(+) 10, with 0 being the default. 
 
The user can adjust the Pitch simply by changing the voice rate.  Moving the slider to the left 
will decrease the pitch, sliding it to the right increases the pitch.  As both the Rate and Pitch 
are being adusted, the user will hear the actual sounds of the new settings. 
 
Select the OK button to close the widow and save the changes.  The selected changes will be 
set to the current document and will also be saved as the default.  The next document added 
will have these voice settings.  If  the document is not opened the voice setting will be set as 
the default and will be applied to the next file added to Text-To-Audio. 
 
Selecting the CANCEL button will close the window without saving any of the changes. 
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Zoom 
 

The system is equipped with a zoom feature.  The zoom feature allows the user to Zoom 
from 25% to 400% of the current font.  The Reader will also work at any magnification level.  
The default setting is 100%.  To Zoom in or out, open Select The Settings menu by pressing 
ALT+T, and select the Zoom feature from the menu.  The Zoom sub menu will open, giving 
the user a list all of the available percentages.  Select the desired percentage,  to change the 
font size. 
 

Help 
 

This entire manual is located in the Help file and is available in Braille upon request.  There 
are two ways to open the Help menu.  Press F1 or ALT+H and then select HELP.  This help 
file is in the traditional Microsoft Windows Help File format. 

 
 

Help About 
 

The Help About box is a small window which tells the user what version is being used and 
the contact information.  To open the Help About window, simply press ALT+H to open the 
Help menu, and then select HELP ABOUT.  The following window will be displayed: 
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System Requirements 

System Requirements 
 
 

CPU:  500 Mhz Pentium Processor or Faster (300 or faster is recommended) 
 Memory: 256  (512 MB or higher is recommended) 
 Sound Card:  16 Bit with Speakers 
 Key Board:  Standard 104 Key 
 Disk Space:  600 MB of Free Disk Space 
 CD-ROM:  10X or faster 
 
 

Operating System 
 

  
Windows XP Home 
Windows XP Professional 
Windows Vista 
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Frequently Ask Questions 

 

How do I make a “book on tape”? 
 
You can make a book on CD or the hard drive on your PC.   We recommend breaking a book 
up into chapters, and making each chapter its own file.  This is done by selecting all the 
chapters and turning them into audio files.  The user will need to use Standard Wave, GSM 
or DSP audio formats.  Once User is done creating the audio file on the hard drive, the CD 
can now be created.  Note: This is the software originally included with the CD burner or 
computer.  Simply go into the CD Burning software and add a single chapter per track.  This 
allows the user the ability to fast forward to the desired chapter while also listening to it. 
 

What audio file types work best for audio CD’s so I can play them 
in a regular stereo? 
 
Standard Wave:  The most common file type.  Standard Wave also offers the best possible 
sound quality.  
 
GSM:  GSM is very similar to Standard Wave files, but with an approximate a 3 to 1 
compression.  However, GSM files take longer to process due to the compression. 
 
DSP:  Use DSP for large volumes of information in a small file.  The quality is slightly lost, 
however, the compression rate can be as high as 50 to 1. 
 

How much space is required for an audio file? 
 
Generally, for every minute of good quality audio (non-compressed) approximately 500K of 
disk space is required.  Thus, a 10-minute audio file will take up about 5 MB of disk space, 
or 30MB for an hour of audio. 
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How can I determine the length and size of an audio file prior to it 
being created? 
 
If default settings are used, Text-To-Audio will produce approximately 1 minute of audio for 
every 1,000 characters.  A 10,000 character document will thus produce 10 minutes of audio 
and create a 5 MB file. 
 
 

Can Text-To-Audio read the Internet? 
 
Text-To-Audio is designed to convert documents into audio files.  If the user saves to a text-
based file, Text-To-Audio can read the file.  However, Text-To-Audio can’t directly read 
from the Internet. 
 

Can Text-To-Audio work with foreign Languages? 
 
Absolutely !  German, French, Spanish, Dutch, Portuguese, and Italian languages are all 
convertible with Text-To-Audio.  However, a “Text To Speech Engine” is required which 
speaks those languages.  Those speech engines are available from AT&T and other software 
vendors. 
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Glossary of Terms 

VOX 
VOX are Dialogic audio files used with the dialogic telephony card. 

OGG 
OGG provides great compression without losing any information.  This is a good 
compression for music, but for speech where retaining 100 percent of the original 
sampling is not required, other formats will give you higher compression. 

G726 
Like GSM, G726 provides a good compression ratio similar to GSM and works well 
with voice.  Not many devices can use this standard. 

GSM 
GSM File compression can give a 5 to 1 compression ratio over standard wave files.  
GSM gives a high quality output with good file compression and is a good format for 
speech. 

DSP 
DSP produces the highest compression ratio of all the file types.  DSP will produce a 
wave file that can achieve a compression ratio of nearly 50 to 1.  This file format is 
the preferred format. 

ALF 
ALF2 CD Audio Codec is of high quality and is a fast encoder/decoder of audio 
data, written in CD Audio standard (44100 Hz, 16 bit, Stereo).  ALF2 CD Audio 
Codec allows the user to encode and decode with the following bitrates: 256 Kbps, 
320 Kbps, 384 Kbps, 512 Kbps  

ADPCM 
This method of encoding sound data files takes up less storage space than the regular 
PCM format used by WAV and AIFF file. 
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Standard Wave 
Standard Wave file is an uncompressed wave.  This will create the largest of all the 
file types.  Use this file format if you need a natural wave file. 

MP3 
The MP3 Files provide a good compression ratio.  MP3 also supports variable 
speeds.  The compression ratio is directly related to the bit rate settings.  Text-To- 
Audio supports sampling rates from 16 to 256 Bits. 

Output Type 
Text-To-Audio can generate 9 different file types.  The default file type is MP3.  The 
useru can select the output type from this list or from the settings menu and select 
output type 

Voice Pitch 
The voice pitch is the numeric value of the pitch used during the creation of the 
audio file.  The pitch of the reading voice can be adjusted by double clicking it, or 
going to the settings menu and selecting "Voices". 

Voice Rate 
The voice rate is the speed at which Text-To-Audio speaks. This rate cannot be 
adjusted once the file has been created.  The Range for the speed is from a (-) 10 to 
(+) 10, with 0 being the default speed.  To change this value, double click this field 
or go to the settings menu and select "Voices". 

Voice Rate 
Is the speed at which the text will be read 

File Size 
File size is the number of characters being read. 

Voice 
This is the voice used to read the document 

File Name 
The name of the source file used to create the audio file 

Output File Name 
The name of the created audio file.  
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